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Preface
The Quartus® II Installation & Licensing for PCs manual provides the 
information you need to install and start the Quartus II design software.

This manual is intended for all Quartus II software users, from beginning to 
advanced.

This manual provides comprehensive information for installing and 
licensing the Quartus II software, and includes information about the 
following topics:

■ How to install the Quartus II software and related software.

■ How to license the Quartus II software correctly.

■ Other documentation and technical support information.
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Documentation Conventions
The Quartus® II Installation & Licensing for PCs manual uses the following 
conventions to make it easy for you to find and interpret information.

Typographic Conventions

Quartus II documentation uses the typographic conventions shown in the 
following table:

Visual Cue Meaning

Bold Initial 
Capitals

Command names; dialog box, page, and tab titles; and button names 
are shown in bold, with initial capital letters. For example: Find Text 
command, Save As dialog box, and Start button.

bold Directory names, project names, disk drive names, file names, file 
name extensions, software utility names, software executable 
names, and options in dialog boxes are shown in bold. Examples: 
quartus directory, d: drive, license.dat file. 

Initial Capitals Keyboard keys, user-editable application window fields, and menu 
names are shown with initial capital letters. For example: Delete key, 
the Options menu.

“Subheading 
Title”

Subheadings within a manual section are enclosed in quotation 
marks. In manuals, titles of Help topics are also shown in quotation 
marks.

Italic Initial 
Capitals

Help categories, manual titles, section titles in manuals, and 
application note and brief names are shown in italics with initial 
capital letters. For example: FLEXlm End Users Guide.

italics Variables are enclosed in angle brackets (< >) and shown in italics. 
For example: <file name>, <CD-ROM drive>.

Courier font Anything that must be typed exactly as it appears is shown in 
Courier. For example: \quartus\win\lmutil lmhostid.

r Enter or return key.

■ Bullets are used in a list of items when the sequence of the items is 
not important.

v The checkmark indicates a procedure that consists of one step only.

! The hand points to information that requires special attention.
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Terminology

The following table shows terminology that is used throughout the 
Quartus II Installation & Licensing for PCs manual:

f The feet show you where to go for more information on a particular 
topic.

w The exclamation mark points to information or action that you take 
that can cause harm to your computer or cause you to lose data.

Visual Cue Meaning

Term Meaning

“click” Indicates a quick press and release of the left mouse button. It 
also indicates that you need to use a mouse or key combination 
to start an action.

“double-click” Indicates two clicks in rapid succession.

“select” Indicates that you need to highlight text and/or objects or an 
option in a dialog box with a key combination or the mouse. A 
selection does not start an action. For example: Select Chain 
Description File, and click OK.

“turn on”/“turn off” Indicates that you must click a check box to turn a function on 
or off.
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Introduction
This chapter describes the requirements and procedures for installing the 
following software CD-ROM versions (some listed CD-ROMs may not be 
included in your current Altera® Package):

■ Quartus® II Design Software for Windows Version 6.0
■ Altera VHDL & Verilog HDL Simulation Tool for Use with the 

Quartus II Software (ModelSim®) Version 6.0e
■ MegaCore® IP Library Version 6.0
■ Nios® II Embedded Design Suite, Evaluation Edition, Version 6.0 for 

Windows

Quartus II System Requirements
Your system must meet the following minimum requirements:

■ Intel Pentium II PC running at 400 MHz or faster with 256-MB system 
memory (faster systems give better software performance).

■ Disk space requirements, as described in the Quartus II readme.txt file, 
which is located in the top-level directory of the Quartus II software 
CD-ROM. After installation, the readme.txt file is available from the 
Quartus II Help menu and in the Quartus II system directory.

■ Microsoft Windows 2000, Windows XP, or Windows XP Professional 
x64 Edition

■ Microsoft Windows–compatible SVGA monitor

■ CD-ROM drive

■ One or more of the following ports:

– Parallel port for use with the ByteBlaster™ II or ByteBlasterMV™ 
parallel port download cable or Parallel Port Software Guard

– Serial port for use with the MasterBlaster™ communications cable
– USB port for use with the USB-Blaster™ download cable, the 

MasterBlaster communications cable, the Altera Programming 
Unit (APU), or the USB Software Guard (Windows 2000, Windows 
XP, or Windows XP Professional x64 Edition only)
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– 10/100 Mb Ethernet connection for use with the EthernetBlaster 
download cable

Uninstalling Previous Versions of 
the Quartus or Quartus II Software

If you have installed a previous version of the Quartus® or Quartus II 
software, you can uninstall that software, if you wish, before installing the 
current version of the Quartus II software.

To uninstall a previous version of the Quartus or Quartus II software:

v On the Windows Start menu, point to Programs, click Altera, and then 
click Quartus <version number> Uninstall, Repair or Modify.

f For Information About Refer To

Specific disk space and memory 
requirements

Quartus II readme.txt file, which is located 
in the top-level directory of the Quartus II 
software CD-ROM. After installation, the 
readme.txt file is available from the 
Quartus II Help menu and in the Quartus II 
system directory.

Updated information about system 
requirements and the most current 
version of the Quartus II Installation & 
Licensing for PCs manual

Quartus II Installation & Licensing for PCs 
manual on the Altera website.

Latest information on new features, 
device support, EDA interface support, 
and known issues and workarounds 
for the Quartus II software

Quartus II Software Release Notes 
document on the Altera website.

Quartus II software features and how 
they work with your design flow

Introduction to Quartus II manual on the 
Altera website.

Altera programming hardware Altera Programming Unit User Guide, 
ByteBlaster II Download Cable User Guide, 
ByteBlasterMV Download Cable User Guide, 
EthernetBlaster Download Cable User 
Guide, MasterBlaster Serial/USB 
Communications Cable User Guide, and 
USB-Blaster Download Cable User Guide on 
the Altera website.
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Installing the Quartus II Software
The Quartus II software uses a Setup program for installation.

You should be aware of the following information before you install the 
Quartus II software:

■ You must have system administration (Administrator) privileges.

■ You must have both disk one and disk two of the Quartus II Design 
Software for Windows CD-ROMs to perform the installation. You 
begin the installation with disk one and are prompted to insert disk two 
when necessary.

■ By default, the Setup program installs the Quartus II software in the 
<drive>:\altera\quartus<version number> system directory, where 
<version number> is the number of the Quartus II software version; for 
example, the default directory for the Quartus II software version 6.0 is 
<drive>:\altera\quartus60.

■ You can install multiple copies of the same version of the Quartus II 
software on the same PC. Subsequent installations of the Quartus II 
software can have a user-defined name. By default, the Setup program 
uses the format “Quartus II <version number> (Copy <number>)” for 
multiple copies, where Copy <number> is the number of Quartus II 
software installations that are installed on the PC. When installing a 
Quartus II service pack on a PC that has multiple copies of the same 
version of the Quartus II software installed, the installation program 
allows you to choose the copy of the Quartus II software that will 
receive the service pack.

■ If you want to preserve project compilation databases from an earlier 
version of the Quartus II software before installing a newer version, 
Altera recommends that you open the design in the earlier version of 
the software and export a version-compatible database for the design 
by clicking Export Database on the Project menu. After you have 
installed a newer version of the Quartus II software, you can import the 
database in the new version by clicking Import Database on the Project 
menu. For more information about importing and exporting version-
compatible databases, see “Exporting and Importing Version-
Compatible Database Files” in Quartus II Help. Version-compatible 
database files are available in Quartus II software version 4.1 and later.
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Follow these steps to run the Setup program on your PC:

1. Insert disk one of the Quartus II Design Software for Windows 
CD-ROM into your CD-ROM drive. The Quartus II Install CD window 
appears automatically, offering several options. If the CD-ROM is in the 
drive, and the Setup program is not already running, start the Setup 
program manually by performing the following steps:

a. On the Windows Start menu, click Run.

b. In the Run dialog box, type <CD-ROM drive>:\install.

c. Click OK.

2. Click Install Quartus II and Related Software to install the Quartus II 
software and related software. The Setup program starts automatically 
and guides you through the installation process.

You can select a full installation or a custom installation. If you select a 
custom installation, you can select which device families you want to 
install, and you can also select whether you want to install EDA 
interfaces or tutorial files.

! Installing Related Software

The Setup program also allows you to install the ModelSim-Altera software, 
the MegaCore IP Library, and the Nios II Embedded Design Suite, Evaluation 
Edition. The CD-ROMs for this software are included in the Quartus II 
subscription packages, but may not be included in the Altera development 
and Altera partner kits. To install these programs, make sure the 
ModelSim-Altera, MegaCore IP Library, or Nios II Embedded Design 
Suite, Evaluation Edition options are turned on in the Setup program, and 
follow the installation process for those CDs. If you decide to install these 
software tools at another time, follow the installation instructions located in 
“Installing the ModelSim-Altera Software” on page 6, “Installing the MegaCore 
IP Library” on page 7, or “Installing the Nios II Embedded Design Suite” on 
page 8.

! Installing Device Support Required for the Quartus II Tutorial

You must install support for Cyclone™ EP1C6 devices if you want to complete 
the Quartus II tutorial.
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3. If you want to install the Stand-Alone Programmer and the Stand-
Alone SignalTap® II Logic Analyzer, click Install Stand-Alone 
Programmer. The Setup program starts automatically and guides you 
through the installation process.

4. If you will run the Quartus II software with a network (multiuser) 
license, and not a node-locked (single-user) license, click Install 
FLEXlm Server to install the FLEXlm License Manager software on the 
license server only. The Setup program installs the FLEXlm License 
Manager version 9.2 on the user workstation.

The Quartus II software supports network license servers on PCs 
running Windows 2000, Windows XP, or Windows XP Professional 
x64 Edition; on UNIX workstations running Solaris 8 or 9; and on PCs 
running Linux (Red Hat Enterprise Linux 3.0 or 4.0). You do not need 
to install the FLEXlm License Manager software on network client PCs 
or on PCs running the Quartus II software using a node-locked 
(single-user) license. Refer to “Upgrading or Setting Up a License Manager 

Server” on page 18 for more information about setting up the license 
manager server.

5. You can turn on the TalkBack feature in the Quartus II software to 
enable Altera to receive limited compilation design information, but 
not design logic. The TalkBack feature helps Altera to understand how 
customers use the Quartus II software and devices, so Altera can focus 
on improving features most important to users.

You can turn on the TalkBack feature by turning on Turn on the 
Quartus II software TalkBack feature in the TalkBack Options dialog 
box, which appears at the end of the Quartus II software installation 
process if the option is not already turned on. You can also turn the 
TalkBack feature on or off , once you have installed the Quartus II 
software, in the TalkBack Options dialog box from the Internet 
Connectivity page in the Options dialog box.

Installing the ModelSim-Altera 
Software

You can install the ModelSim-Altera software on PCs running Windows 
2000, Windows XP, or Windows XP Professional x64 Edition. The 
ModelSim-Altera readme.txt file in the modelsim directory on the CD-ROM 
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provides information on the ModelSim-Altera software operating 
requirements and licensing. You should read the readme.txt file before 
installing the ModelSim-Altera software.

To install the ModelSim-Altera software on a PC, follow these steps:

1. Insert the Altera VHDL & Verilog HDL Simulation Tool for Use with 
the Quartus II Software (ModelSim) CD-ROM into your CD-ROM 
drive.

2. On Windows Start menu, click Run.

3. In the Run dialog box, type <CD-ROM drive>:\modelsim\pc\
modelsim-altera.exe.

4. Click OK. The Setup program starts automatically and guides you 
through the installation process.

Installing the MegaCore IP Library
You can install the MegaCore IP Library on PCs running Windows 2000, 
Windows XP, or Windows XP Professional x64 Edition. The MegaCore IP 
Library readme.txt file in the top-level directory on the CD-ROM provides 
information on the MegaCore IP Library. You should read the readme.txt 
file before installing the MegaCore IP Library.

To install the MegaCore IP Library on a PC, follow these steps:

1. Insert the MegaCore IP Library CD-ROM into your CD-ROM drive.

2. On Windows Start menu, click Run.

3. In the Run dialog box, type <CD-ROM drive>:\windows\
setup.exe.

4. Click OK. The Setup program starts automatically and guides you 
through the installation process.
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Installing the Nios II Embedded 
Design Suite

You can install the Nios II Embedded Design Suite, Evaluation Edition on 
PCs running Windows 2000, Windows XP, or Windows XP Professional 
x64 Edition. The Nios II Embedded Design Suite readme.txt file in the top-
level directory on the CD-ROM provides information on the Nios II 
Embedded Design Suite. You should read the readme.txt file before 
installing the Nios II Embedded Design Suite.

To install the Nios II Embedded Design Suite on a PC, follow these steps:

1. Insert the Nios II Embedded Design Suite, Evaluation Edition for 
Windows CD-ROM into your CD-ROM drive.

2. On Windows Start menu, click Run.

3. In the Run dialog box, type <CD-ROM drive>:\launcher.exe.

4. Click OK. The Setup program starts automatically and guides you 
through the installation process.

Installing the TCP/IP Protocol
If you do not already have the TCP/IP protocol installed on the PCs in your 
network, you must add it to your networking configuration.

f For Information About Refer To

Using MegaCore functions with the 
Quartus II design software

MegaCore user guides that are installed 
with the MegaCore IP Library and on the 
Altera website.



CHAPTER 1: INSTALLING THE QUARTUS II SOFTWARE

INSTALLING THE TCP/IP PROTOCOL

9 ■ INSTALLATION & LICENSING FOR PCS ALTERA CORPORATION

f For Information About Refer To

Installing the TCP/IP protocol on PCs 
running Windows 2000, Windows XP, 
or Windows XP Professional x64 
Edition

Windows 2000, Windows XP, or Windows 
XP Professional x64 Edition documentation 
or to the Microsoft website at 
www.microsoft.com.
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Introduction
This chapter describes how to license the Quartus II software.

To set up your license for the Quartus II software, you must perform the 
following steps, which are described in more detail in this chapter:

1. If necessary, obtain a license file. The Quartus II software requires a 
valid, unexpired license.dat license file for each server that supports a 
network (multiuser) license or for each node-locked (single-user) 
license. This same license file can also enable the additional Altera 
simulation tools included with Altera software subscriptions, as well as 
the MAX+PLUS II software.

2. If you are using a network license (FLOATPC, FLOATNET, or 
FLOATLNX), modify the license file.

3. If you are using a network license, set up and configure the FLEXlm 
license manager server.

or

If you are using a node-locked (FIXEDPC) license, install a Sentinel 
Software Guard.

4. Start the Quartus II software.

5. Specify the location of the license file.

6. Register for an Altera.com account. (Optional)

! Using Automatic Web License Retrieval

If you are using a node-locked (FIXEDPC) license and are a new user or are upgrading 
to a new version of the Quartus II software, you can perform an automatic web 
license retrieval at startup, which allows you to upgrade your license file 
automatically. For more information on this option, go to “Starting the Quartus II 
Software” on page 27.
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Obtaining a License File
When you start the Quartus II software, if the software cannot detect a valid 
license file, you are asked whether you want to run in evaluation mode for 
30 days, perform an automatic license retrieval from the Altera website, or 
specify the correct location of a valid license file.

You can also obtain a license file, license.dat, from the Licensing section of 
the Altera website at www.altera.com/licensing if you have the following 
information:

■ Your Altera ID, which is a six-digit number that is provided when you 
purchase the Quartus II development system. This number is listed on 
the packing list that is shipped with the Quartus II software.

■ Your serial number, which can be one of the following numbers:

– If you have a network (multiuser) license version of the Quartus II 
software, the serial number is printed on the side of the Quartus II 
shipping box, and on the Registration & License File Request Form, 
which is also included with the Quartus II software package. This 
number begins with the letter G, and is followed by five digits 
(Gxxxxx).

– If you have a node-locked (single-user) version of the Quartus II 
software, the serial number is the number on your Software 
Guard. This number begins with the letter T.

■ Your Network Interface Card (NIC) number. To find your Windows 
2000, Windows XP, or Windows XP Professional x64 Edition server 
NIC number by using FLEXlm utilities, type the following command at 
a command prompt:

<drive>:\altera\quartus<version number>\win\lmutil 
lmhostid r

! Saving Previous license.dat Files

Altera recommends that you save any previous license.dat file in a temporary 
directory, in case you need to refer to it later.
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To obtain a license file, follow these steps:

1. Start the Quartus II software as described in the “Starting the Quartus II 

Software” on page 27.

2. Select Perform automatic web license retrieval to request a valid 
license file automatically from the Altera website. If you are using a 
node-locked (FIXEDPC) license and the Quartus II software is able to 
retrieve a license file successfully from the website, you can skip the 
remaining steps of this procedure. If you are using a network 
(multiuser) license, or if the Quartus II software is not able to retrieve a 
license file, you are guided through the licensing procedure.

or

To request a license file at a later time, go to the Licensing section of the 
Altera website at www.altera.com/licensing. The Altera Software 
Licensing page appears.

3. If you are using a node-locked (single-user) license, select the FIXEDPC 
license option. 

or

If you are using a network (multiuser) license, select the FLOATPC, 
FLOATNET, or FLOATLNX license option.

4. Specify the requested information.

5. You will receive an e-mail from Altera with a license.dat file attached, 
as well as the license file text. Altera recommends using the attached 
license file if you are using a node-locked (single-user) license. If you 
are using a network (multiuser) license, you may either use the 
attached license file, or copy the lines from the attached license file to 
an existing license file. If you are using the license.dat file with both the 
Quartus II software and the MAX+PLUS II software, Altera 
recommends that you save the license.dat file in a top-level directory 
named <drive>:\flexlm.
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Figure 1 shows the Quartus II FEATURE line of a sample license file for a 
node-locked (single-user) license that uses a Software Guard.

Figure 1. Sample Node-Locked (Single-User) License File

Figure 2 on page 15 shows a sample single-server network license file for a PC.

f For Information About Refer To

Additional methods of finding your NIC 
number

Altera Find Answers page, which is 
available from the Support Center section 
of the Altera website at 
www.altera.com/answers.

Using the FLEXlm utilities FLEXlm End Users Guide, which is available 
from the Support Services section of the 
Macrovision website at 
www.macrovision.com.

FEATURE quartus alterad 2006.12 permanent uncounted 2BC9FE52E0F3 \
HOSTID=GUARD_ID=T000002287 SIGN="1C66 DAC6 1DAB C886 727B 65DF FAC2 B479 3E3C \ 
656D 3561 E5D0 BBA3 C45C 4DDC 0F2F 68F5 4DF1 6F63 7785 2F5D 1480 1B0A 70DE \ 
2220 1952 DDCD 9F4D 6D61 A177"

Feature 
name

Daemon 
name

Release 
date

Expiration 
date

Number of 
licenses 
requested

Authorization 
code
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Figure 2. Sample Single-Server Network License File

If you are using the Quartus II software with a node-locked (single-user) 
license, skip to “Installing a Sentinel Software Guard” on page 24.

The FLEXlm licensing scheme allows you to set up three redundant license 
servers to serve a network (multiuser) license. You can obtain a license file 
for redundant servers by performing the steps described earlier in this 
section for obtaining a license file. Figure 3 shows a sample redundant server 
license file.

Figure 3. Sample Redundant Server License File

SERVER alice 00c04f6bead6 1800
VENDOR alterad "<drive>:\altera\quartus42\win\alterad.exe"
USE_SERVER
FEATURE quartus alterad 2006.12 permanent 5 7A496D25A602 SIGN="1C66 DAC6 1DAB C886 \ 

727B 65DF FAC2 B479 3E3C 656D 3561 E5D0 BBA3 C45C 4DDC 0F2F 68F5 4DF1 6F63 \ 
7785 2F5D 1480 1B0A 70DE 2220 1952 DDCD 9F4D 6D61 A177"

Server 
host ID 
name

Optional port 
number

Authorization 
code

Number of 
licenses 
requested

Server 
name

Feature 
name

Daemon 
name

Release 
date

Expiration 
date

SERVER alice 00c04f6bead6 1800
SERVER king 00c4fbbd170 1800
SERVER queen 00c4fbbd320 1800
VENDOR alterad "<drive>:\altera\quartus42\win\alterad.exe"
USE_SERVER
FEATURE quartus alterad 2006.12 permanent 5 7A496D25A602 SIGN="1C66 DAC6 1DAB C886 \ 

727B 65DF FAC2 B479 3E3C 656D 3561 E5D0 BBA3 C45C 4DDC 0F2F 68F5 4DF1 6F63 \ 
7785 2F5D 1480 1B0A 70DE 2220 1952 DDCD 9F4D 6D61 A177"

Server ID 
number

Optional port 
number

Authorization 
code

Number of 
licenses 
requested

Server 
name

Feature 
name

Daemon 
name

Release 
date

Expiration 
date
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Modifying the License File
If you have a network (multiuser) license, the license.dat file must be 
modified before it can be used by the license server. See Application Note 340 
(Altera Software Licensing), which is available from the Literature section of 
the Altera website at www.altera.com/literature, for a detailed description 
of the license file.

The first few lines of the license file are shown in the following example 
(your license file may not contain all the VENDOR entries, depending on 
which software you have enabled):

SERVER <host name> <8- or 12-character host or NIC ID> <port number>
VENDOR alterad "<path to daemon executable>"
VENDOR mgcld "<path to daemon executable>"

To modify the license file, follow these steps:

1. In the license.dat file, type the variables that are described in Table 1. 
The host or NIC ID will already be entered in the license file.

f For Information About Refer To

Setting up and administering license 
servers, including setting up three 
redundant license servers

FLEXlm End Users Guide, which is available 
from the Support Services section of the 
Macrovision website at 
www.macrovision.com.

! If You Have a Node-Locked (Single-User) License

If you have a node-locked (single-user) license, you can skip this section and go to 
“Installing a Sentinel Software Guard” on page 24.
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2. Make sure the license file meets these guidelines:

– The license file name must have a .dat extension. If your text editor 
adds .txt or another extension to the file name, such as 
license.dat.txt, you must rename the file to have only a .dat 
extension.

– The license file must have a carriage return at the end of the last 
FEATURE line.

– Any FEATURE line that wraps to a second or third line must 
contain a backslash (\) at the end of each line to indicate that it 
continues.

Table 1. Variables to Modify in the License File (license.dat) 

Variable Name Description Directory

<host name> The host name of the server; for example, my_server.

<port number> 
(1)

The port number for the license manager service on the server; for 
example, 1800. The port number is optional and should be different 
from the port number for any other service on the machine.

alterad "<path 
to daemon 
executable>" (2)

Path to the Altera vendor 
daemon executable alterad.

\<Quartus II system directory>\
win\alterad.exe

mgcld "<path to 
daemon 
executable>" 
(2)(3)(4)

Path to the Mentor Graphics 
vendor daemon executable 
mgcld.

\<ModelSim-Altera system 
directory>\win32aolem\
mgcld.exe

Notes:
(1) If you do not specify a port number in the license file, the FLEXlm License Manager will 

automatically choose a free port between 27000 and 27009. However, to prevent port number 
conflicts, you can specify a port number. If three redundant servers are being used, you must 
specify a port number. For PC-based license servers, Altera recommends that you specify a port 
number of 1800. However, you can use any unused port number between 0 and 64000. 

(2) In some network environments, the license server does not have an installation of the software 
tool(s) that provides the necessary vendor daemon (alterad or mgcld). In this case, copy the 
required daemon from another machine that does have an installation of the software. Find the 
file in the directory location specified. Save the file in a similarly named directory or any other 
location on the license server. Specify the daemon location on the license server in the license 
file. 

(3) If the path to the server has spaces in it, enclose the full path in quotation marks. 
(4) If you are not using a license file for the ModelSim-Altera software, you may delete this line.
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Upgrading or Setting Up a License 
Manager Server

This section provides instructions for upgrading or setting up the FLEXlm 
License Manager server software on a PC running Windows 2000, Windows 
XP, or Windows XP Professional x64 Edition. A system administrator 
should perform these steps to configure license servers after the Quartus II 
software is installed.

Upgrading the FLEXlm License Server 
Software

To support network licensing, the Quartus II software requires the FLEXlm 
License Manager software version 8.0 or later. The Quartus II Setup program 
installs version 9.2 of the FLEXlm License Manager server software on your 
user workstation, but you should also verify that the version of the FLEXlm 
License Manager software or the license server is 8.0 or later. Go to “Installing 

the Quartus II Software” on page 4 for more information on installing the 
FLEXlm License Manager server software. If the FLEXlm License Manager 
software is version 8.0 or later, skip to “Rereading an Existing License File” on 

page 19.

To determine which version of the FLEXlm License Manager server software 
you are using: 

v On the computer running the FLEXlm License Manager server 
software, type the following commands at a command prompt:

f For Information About Refer To

Modifying the license file for the 
Quartus II and MAX+PLUS II software 
and for other EDA tools

Application Note 340 (Altera Software 
Licensing) on the Altera website.

! If You Have a Node-Locked (Single-User) License

If you have a node-locked (single-user) license, you can skip this section and go to 
“Installing a Sentinel Software Guard” on page 24.
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<drive>:\<FLEXlm system directory path>\lmgrd -v r
<drive>:\<FLEXlm system directory path>\alterad -v r

If the lmgrd or alterad daemons are not from the FLEXlm software version 
8.0 or later, you must upgrade both daemons with the versions provided in 
the installation of the Quartus II software.

To upgrade an older version of the FLEXlm License Manager server 
software, follow these steps:

1. Make a backup copy of the lmgrd and alterad daemons you are 
currently using.

2. To overwrite or replace the daemons you are currently using, copy the 
new versions of the files to the computer running the license server. 
You may have to shut down the license server software to complete this 
step.

If you used the Quartus II Setup program to install the FLEXlm License 
Manager server software, the current version of the lmgrd and alterad 
daemons are located in the following directories:

<drive>:\<Quartus II system directory>\win\alterad
<drive>:\<Quartus II system directory>\win\lmgrd

3. Copy the FLEXlm software lmutil utility from the Quartus II system 
directory to the license server.

4. Restart the FLEXlm license server by typing the following commands 
at a command prompt:

<drive>:\<FLEXlm system directory path>\lmutil -c lmdown 
<license file path> r

<drive>:\<FLEXlm system directory path>\lmgrd -c <license file path> 
[-l <optional log path>] r

Rereading an Existing License File

The Quartus II software uses the FLEXlm software to administer licensing 
for single users or for multiple users in a network installation. If you have an 
existing FLEXlm license server with an existing license file for the 
MAX+PLUS II software or software from another vendor, and the FLEXlm 
license server is version 8.0 or later, you can add, by copying and pasting, 
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the Altera FEATURE lines from your Quartus II license.dat file into your 
existing license file. Paste the Quartus II FEATURE line as shown in the 
sample license file in Figure  on page 15. Make sure you have also modified 
the license file according to the guidelines in “Modifying the License File” on 

page 16.

If you make these changes to your license file, you must reread the license 
file or restart the license server before you can run the Quartus II software 
for the first time. 

Refer to “Upgrading or Setting Up a License Manager Server” on page 18 to verify 
that you are using the latest supported version of the FLEXlm License Server 
software, or if you need to upgrade an older version of the FLEXlm License 
Server software.

To reread your license file on a license server:

v Type the following command at a command prompt:

<drive>:\<Quartus II system directory>\win\lmutil lmreread r

or

v Restart the license server.

! Configuring a New License Server

If you do not have an existing FLEXlm license server, and you need to configure a 
new license server, skip to “Configuring a New License Server” on page 21.

f For Information About Refer To

Using the FLEXlm utilities to administer 
and troubleshoot the FLEXlm License 
Manager software

FLEXlm End Users Guide, which is available 
from the Support Services section of the 
Macrovision website at 
www.macrovision.com.
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Configuring a New License Server

The Quartus II software uses the FLEXlm software to administer licensing 
for single users or for multiple users in a network installation. If you do not 
have an existing FLEXlm license server, you must configure a license server 
before starting the Quartus II software for the first time.

To launch a new license server:

v Type the following command at a command prompt:

<drive>:\<Quartus II system directory>\win\lmgrd -c
<license file path>\license.dat r

To configure a new license server as a Windows service:

1. Type the following command at a command prompt:

lmtools r

2. In the LMTOOLS dialog box, click Configuration using Services.

3. Click the Config Services tab.

4. In the Service Name box, type Flexlm License Server.

! Before You Configure a New License Server

You should be aware of the following information before you configure a new 
license server:

■ Configuring a new license server requires that you have system administration 
(Administrator) privileges.

■ If you have an existing FLEXlm license server, refer to “Rereading an Existing 
License File” on page 19.

■ Make sure you have obtained a valid license file according to the guidelines in 
“Obtaining a License File” on page 12, and that you have modified the license 
file according to the guidelines in “Modifying the License File” on page 16.

■ These instructions assume that you have installed the license.dat file in the 
<drive>:\flexlm directory. If you have installed the license file in a different 
directory, substitute the appropriate path name for that directory.
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5. In the Path to the lmgrd.exe file box, type the location of your lmgrd 
file, usually the <drive>:\<Quartus II system directory>\win 
directory.

6. In the Path to the license file box, type the location of your license.dat 
file, usually the <drive>:\flexlm directory.

7. In the Path to the debug log file box, type the location of your debug 
log file, usually the <drive>:\flexlm\debug.log directory.

8. Click Save Service.

Starting and Stopping the License 
Server

When configuring the license server, you can start and stop the license 
server with the LMTOOLS dialog box. Before you start or stop the license, 
you must configure a new license server as a Windows service. Refer to 
“Configuring a New License Server” on page 21 for more information.

To start or stop the license server with the LMTOOLS dialog box:

1. Type the following command at a command prompt:

lmtools r

2. In the LMTOOLS dialog box, click Configuration using Services.

3. Select the name of the license server, usually Flexlm License Server.

4. Click the Start/Stop/Reread tab.

f For Information About Refer To

Configuring a new UNIX workstation 
license server

Quartus II readme.txt file.

Setting up and administering license 
servers, including setting up three 
redundant license servers

FLEXlm End Users Guide, which is available 
from the Support Services section of the 
Macrovision website at 
www.macrovision.com.
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5. To start the server, click Start Server.

or

To stop the server, click Stop Server.

Starting the License Server 
Automatically at Startup

When configuring the license server, you can setup the license server to start 
automatically at startup with the LMTOOLS dialog box. Before you setup 
the license server to start automatically at startup, you must configure a new 
license server as a Windows service. Refer to “Configuring a New License Server” 

on page 21 for more information.

To start the license server automatically at startup with the LMTOOLS 
dialog box:

1. Type the following command at a command prompt:

lmtools r

2. In the LMTOOLS dialog box, click Configuration using Services.

3. Select the name of the license server, usually Flexlm License Server.

4. Click the Config Services tab.

5. Turn on Use Services.

6. Turn on Start Server at Power Up.

Installing the FLEXlm Software on 
Another License Server

You can install the FLEXlm software on an additional license server.

To install the FLEXlm software on another license server, perform the 
following steps:
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1. Create a directory named <drive>:\<Quartus II system directory>\
win on the additional license server.

2. Copy the following files from the <drive>:\<Quartus II system 
directory>\win directory of your original Quartus II software into the 
new directory:

– lmgrd
– lmutil
– alterad
– lmtools

You can also install the FLEXlm software on another license server with the 
Install FLEXlm Server button in the Setup program. Refer to “Installing the 

Quartus II Software” on page 4 for more information.

Installing a Sentinel Software Guard
If your Quartus II development system uses a node-locked license and 
includes a Sentinel Software Guard, you must make sure the Sentinel driver 
is installed and then install the Software Guard before you can specify a 
license file.

! Before You Install the Sentinel Software Guard

You should be aware of the following information before you install a Sentinel 
Software Guard:

■ If you have a network (multiuser) license, you can skip this section and go to 
“Starting the Quartus II Software” on page 27.

■ Current Quartus II single-user license packages provide USB Software Guards 
only. Parallel Port Software Guards are no longer provided in Quartus II 
software packages; however, they are still supported for backward 
compatibility. Parallel Port Software Guards are not supported on 64-bit 
systems.
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Installing the Sentinel Driver

The Sentinel driver is required for all Quartus II software systems running 
on Windows 2000, Windows XP, or Windows XP Professional x64 Edition 
that use a USB Software Guard, and for systems running on Windows 2000 
or Windows XP that use a Parallel Port Software Guard. The Sentinel driver 
is installed automatically with the Quartus II software.

If the Sentinel driver is not installed, you can install it by following these 
steps:

1. On the Windows Start menu, click Run.

2. If you are installing the USB Software Guard on systems running on 
Windows 2000 or Windows XP, type the following command in the 
Run dialog box:

<drive>:\<Quartus II system directory>\drivers\sentinel\
setup.exe/usb/q3 r

or

If you are installing the USB Software Guard on systems running on 
Windows XP Professional x64 Edition, type the following command in 
the Run dialog box:

<drive>:\<Quartus II system directory>\drivers\sentinel\
win_xp64\sentinst64.exe/S/v“/qn“r

or

If you are installing the Parallel Port Software Guard, type the 
following command in the Run dialog box:

<drive>:\<Quartus II system directory>\drivers\sentinel\
setup.exe/q3 r

! Sentinel Driver Installation Requirement

Installing the Sentinel driver requires that you have system administration 
(Administrator) privileges.



CHAPTER 2: LICENSING THE QUARTUS II SOFTWARE

INSTALLING A SENTINEL SOFTWARE GUARD

ALTERA CORPORATION INSTALLATION & LICENSING FOR PCS ■ 26

3. In the Sentinel Driver Setup Program window, on the Functions 
menu, click Install Sentinel Driver.

4. In the Sentinel Install dialog box, click OK.

5. Restart your computer at the prompt.

Installing the USB Software Guard

To install the USB Software Guard on a PC running Windows 2000, 
Windows XP, or Windows XP Professional x64 Edition, follow these steps:

1. Locate an unused USB port on the computer.

2. Insert the USB Software Guard into the USB port.

Installing the Parallel Port Software 
Guard

To install the Parallel Port Software Guard on a PC running Windows 2000 
and Windows XP, follow these steps:

1. Locate a parallel printer port (that is, an LPT port) on the computer. If 
you have a printer connected to this port, you must disconnect it 
temporarily.

2. Insert the 25-pin male connector end of the Software Guard into the 
25-pin female connector of the parallel printer port, as shown in Figure 4 

on page 27.

! Software Guard Operating System Compatibility

The USB Software Guard is supported only on PCs running Windows 2000, Windows 
XP, or Windows XP Professional x64 Edition.
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Figure 4. Attaching the Parallel Port Software Guard to a PC

3. If necessary, reinsert the printer cable connector into the female 
connector of the Parallel Port Software Guard.

Starting the Quartus II Software
You can start the Quartus II software after installation is complete. In order 
to enable Quartus II features, however, you must specify the license file, 
either within or outside the Quartus II software. For information about how 
to specify your license file, refer to the next section, “Specifying the License 

File.”

To start the Quartus II software:

v On the Windows Start menu, point to Programs, click Altera, and then 
click Quartus II.

Parallel Printer Port
25-Pin Female Connector

Software Guard
25-Pin Female
Connector

w Parallel Port Software Guard Warnings

You should be aware of the following information after you insert a Parallel Port 
Software Guard:

■ Do not connect disk drives that use the parallel port or any device, other than 
a printer or the ByteBlaster II or ByteBlasterMV download cable, to either end 
of the Parallel Port Software Guard. Disk drives can destroy a Parallel Port 
Software Guard by drawing more power than the guard is capable of handling.

■ Disconnect the Parallel Port Software Guard before using the parallel port to 
transfer data between computers using a data transfer program. Failure to do 
so can cause damage to the Parallel Port Software Guard.
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or

v Open a new command prompt window and type the following 
command:

<drive>:\<Quartus II system directory>\win\quartus r
When you start the Quartus II software, if the software cannot detect a valid 
license file, you will see a prompt with the following options:

■ Enable 30-day evaluation period with no license file (no 
programming file support)—This option allows you to continue to use 
the Quartus II software for 30 days without programming file support. 
After 30 days, you must have a valid license file in order to use the 
software.

■ Perform automatic web license retrieval—This option displays the 
Licensing section of the Altera website, which allows you to request a 
license file automatically. If you are using a node-locked (FIXEDPC) 
license, the Quartus II software retrieves the license file automatically 
from the website. If you are using a network (multiuser) license, or if 
the Quartus II software is not able to retrieve a license file, you are 
guided through the licensing procedure. See “Obtaining a License File” on 

page 12 for more information.

■ Specify valid license file—This option displays the License Setup 
page of the Options dialog box, which allows you to specify the 
location of your license file. See the next section, “Specifying the License 

File,” for more information.

Specifying the License File
Once you have obtained a license file and set up a network license server (for 
multiuser licenses) or installed a USB or Parallel Port Software Guard (for 
single-user licenses), you must specify the location of the license file for each 
user (or “client”). You can specify the license file with one of the following 
methods, which are described in more detail in this section:

■ Specify the license file with the Quartus II software

■ Specify the license file with the Windows 2000, Windows XP, or 
Windows XP Professional x64 Edition System control panel
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Specifying the License File within the 
Quartus II Software

You can specify the location of your license file from within the Quartus II 
software.

To specify your license file within the Quartus II software, follow these 
steps:

1. Start the Quartus II software as described in the “Starting the Quartus II 

Software” on page 27.

2. Select Specify valid license file to specify the name of the license file. 
The License Setup page of the Options dialog box appears. Figure 5 
shows the License Setup page.

! Specifying the License File for the ModelSim-Altera Software

If you are using the ModelSim-Altera simulation software, which is included with 
Altera software subscriptions, and/or you are using the MAX+PLUS II software, you 
must specify the license file with the System control panel.

! Specifying the License File from within the Quartus II Software

Specifying the license file from within the Quartus II software does not require 
system administration (Administrator) privileges.

! When Starting the Quartus II Software for the First Time

When you start the Quartus II software, if the software cannot detect a valid 
license file, you are asked whether you want to run in evaluation mode for 
30 days, request a valid license file automatically from the Altera website, or 
specify the correct location of a valid license file.
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Figure 5. License Setup Page of the Options Dialog Box

3. In the License file box, specify the full path name of your license.dat 
file. You can browse to locate your license.dat file. Altera recommends 
that you store the license.dat file in a directory named <drive>:\flexlm.

You can also specify the location of the license file by typing a name of 
the format <port>@<host> instead of a license file path name, where 
<host> is the name of the server on which the license file is stored and 
<port> is the port listed in the license.dat file. Refer to Figure 2 on page 15 
for a sample network license file to determine your port and server 

Current license Option to use LM_LICENSE_FILE variable License file location Web License Update button

Local system information Begin 30-day Grace Period buttonLicensed AMPP/MegaCore functions
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name, and see Table 1 on page 17 for more information about port 
numbers. If there is no port listed in the license.dat file, you can simply 
specify @<host>.

or

If you want to use the current LM_LICENSE_FILE value specified in 
the System Control Panel, turn on Use LM_LICENSE_FILE variable.

4. If you want the Quartus II software to check the Altera website 
automatically for license file updates, click Web License Update.

5. If you want to use the Quartus II software in the “Subscription 
Expiration” grace period and did not already specify that option at 
startup, click Begin 30-day Grace Period. The “Subscription 
Expiration” grace period allows you to use the Quartus II software with 
programming file support for 30 days. When the grace period expires, 
you must obtain an updated license file at the Altera website to 
continue using the Quartus II software with programming file support.

6. Click OK.

The Licensed AMPP/MegaCore functions list of the License Setup page 
lists all of the AMPP and MegaCore functions that are available for the 
license.

Specifying the License File with the 
Windows 2000, Windows XP, or 
Windows XP Professional x64 Edition 
System Control Panel

You can specify the location of your license file from outside the Quartus II 
software by setting system variables in the Windows 2000, Windows XP, or 
Windows XP Professional x64 Edition System Control Panel.

! Specifying Multiple License Files

If you have more than one license file or server, separate the port and host 
specifications with semicolons (;), with no spaces between the names and 
numbers.
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To specify the license file in the Windows 2000, Windows XP, or Windows 
XP Professional x64 Edition System Control Panel, follow these steps:

1. On the Windows Start menu, click Control Panel.

2. Double-click the System icon in the Control Panel window.

3. In the System Properties dialog box, click the Advanced tab.

4. In the Advanced tab, click Environment Variables.

5. Under System Variables, click New. The New System Variable dialog 
box appears.

6. In the Variable Name box, type LM_LICENSE_FILE.

7. In the Variable Value box, type either <drive>:\flexlm\
license.dat or a name of the format <port>@<host>, where <host> is 
the name of the server and <port> is the port listed in the license.dat 
file. Refer to Figure 2 on page 15 for a sample network license file to help 
you determine your port and server name. Refer also to Table 1 on 

page 17 for more information about port numbers. If there is no port 
listed in the license.dat file, you can simply specify @<host>.

8. Click OK.

If you want the Quartus II software to use the LM_LICENSE_FILE setting 
from your System Control Panel rather than from another license file 
setting, make sure Use LM_LICENSE_FILE variable is turned on in the 
License Setup page in the Options dialog box.

! Specifying the License File in System Control Panel

Specifying the license file in the System Control Panel requires that you have 
system administration (Administrator) privileges.

! Specifying Multiple License Files and/or Servers

If you have more than one license file or server, separate the port and host 
specifications with semicolons (;), with no spaces between the names and 
numbers.
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Registering for an Altera.com 
Account

Your copy of the Quartus II software is registered at the time of purchase; 
however, in order to use the mySupport website to view and submit service 
requests, you must also register for an Altera.com account and an Altera 
user name. You can use your Altera user name to access your Altera.com 
account. Although use of the mySupport website requires you to have an 
Altera.com account, this account also makes it easier to use many other 
Altera website features, such as the Download Center, Licensing Center, 
Altera Technical Training online class registration, or Buy On-Line-Altera 
eStore features.

To register for an Altera.com account, follow these steps:

1. Go to the mySupport website:

v To start your web browser and connect to the mySupport website 
while running the Quartus II software, on the Help menu, point 
to Altera on the Web, and then click Quartus II Service Request.

or

v Point your web browser to the mySupport website at 
www.altera.com/mysupport.

2. Follow the instructions on the mySupport website to register for an 
Altera.com account.

If you are not a current Altera subscription user, you can still register for an 
Altera.com account and an Altera user name.
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Starting the Quartus II Tutorial
The online tutorial introduces you to the features of the Quartus II design 
software. It shows you how to create and process your own logic designs 
quickly and easily. The modular design of the tutorial allows you to choose 
the areas of the Quartus II software that you want to learn about. The tutorial 
guides you through the steps required to create, compile, perform timing 
analysis on, simulate, and program a sample finite impulse response (FIR) 
filter design, called fir_filter.

To start the Quartus II tutorial after you have successfully installed the 
Quartus II software:

v On the Help menu, click Tutorial.

After you start the tutorial, the Quartus II window resizes to allow you to 
view the Tutorial window and the Quartus II software simultaneously.

Using Quartus II Help
The Quartus II software includes a platform-independent Help system that 
provides comprehensive documentation for the Quartus II software and 
more details about the specific messages generated by the Quartus II 
software. You can view Help in one of the following ways:

■ Press F1 from a highlighted menu command or active dialog box for 
context-sensitive help.

! Before You Start the Quartus II Tutorial

You should be aware of the following information before you start the Quartus II 
tutorial:

■ You must have installed support for Cyclone EP1C6 devices if you want to 
complete the tutorial. If you did not install support for these devices, refer to 
“Installing the Quartus II Software” on page 4 in Chapter 1, “Installing the 
Quartus II Software.”

■ The tutorial is designed for display online. However, if you want to print one 
or more of the tutorial modules, click Printing Options at the beginning of 
each module and then click the link to open the appropriate printable version.
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■ On the Help menu, click Index to view the Index tab. The Index lets you 
search for and display all Help topics related to a keyword or phrase.

■ On the Help menu, click Search to perform a search with the Search 
tab. The Search finds a maximum of 500 topics containing the search 
keyword.

■ On the Help menu, click Contents to view the Contents tab. The 
Contents outlines the design flow and groups related topics into 
folders, but does not list all the topics in Quartus II Help.

■ On the Help menu, click Messages to view the Messages list. The 
Messages list provides an alphabetical list of all messages and offers 
detailed Help on each message.

■ On the Help menu, click Glossary to view the Glossary list. The 
Glossary list provides definitions to key terminology in the Quartus II 
software.

Getting Help on a Message

To view Help on an individual message, follow these steps:

v In the Messages window, right-click the message on which you want 
to receive Help, and then click Help.

To view the entire alphabetical list of messages:

v On the Help menu, click Messages. 

or

v On the Help menu, click Contents, and then select Messages List from 
the end of the Contents.

f For Information About Refer To

Using Quartus II Help “Help Menu Commands” in Quartus II Help.

“Using Quartus II Help Effectively” in 
Quartus II Help.
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Using Context-Sensitive Help

To view context-sensitive help for a specific item:

v Press F1 from a highlighted menu command or active dialog box for 
context-sensitive help.

or

v Press Shift+F1 or click Context-Sensitive Help  on the toolbar. The 
pointer turns into a Help pointer. You can then point to a menu 
command or active window and click for context-sensitive help.

Printing Help Topics

To print Quartus II Help topics from the Contents tab, follow these steps:

1. In the Contents tab, select the Help folder or Help topic that you want 
to print.

2. Right-click the Help topic, and then click Print.

or

Click Print  on the toolbar.

3. Select the appropriate print option:

– To print the selected topic, select Print the selected topic.

– To print the selected folder and all the topics in the folder, select 
Print the selected heading and all subtopics.

4. Click OK.

! Printing Individual Help Topics

You can also use the Print command or Print button to print any individual Help 
topic you view.
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Contacting Altera
You can contact Altera for technical support and product information.

Technical Support

If you need technical support, you can visit the Altera website or the 
mySupport website, or you can call the Altera Applications Department.

Table 1. Quartus II Technical Support Resources

Resource Description

Altera website: www.altera.com

Includes the Altera Find Answers page, which is available from 
the Support Center section of the Altera website at 
www.altera.com/answers.

mySupport website: www.altera.com/mysupport

or, on the Help menu, point to Altera on the Web, and then 
click Quartus II Service Request in the Quartus II software. 
This website allows you to submit, view, and update technical 
support service requests.

Telephone: (800) 800-EPLD
(7:00 a.m. to 5:00 p.m. Pacific time, M–F) You will need your 
6-digit Altera ID to access the hotline.

(408) 544-8767
(7:00 a.m. to 5:00 p.m. Pacific time, M–F)

! Registering for an Altera.com Account

In order to use the mySupport website to view and submit service requests, you 
must also register for an Altera.com account. An Altera.com account is required only 
for using the mySupport website; however, having an Altera.com account will also 
make it easier for you to use many other Altera website features, such as the 
Download Center, Licensing Center, Altera Technical Training online class 
registration, or Buy On-Line-Altera eStore features. For more information, refer to 
“Registering for an Altera.com Account” on page 33 in Chapter 2, “Licensing the 
Quartus II Software.”
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Product Information

If you need the latest Altera product information or literature, go to the 
Literature section of the Altera website at www.altera.com/literature. You 
can also purchase printed sets of documentation from the Shop Altera 
website at www.shopaltera.com.

f For Information About Refer To

Altera technical support services and 
product information

The Contact Altera section of the Altera 
website.
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Quartus II File Organization
During the Quartus II software installation, two top-level directories are 
created:

■ The \altera\quartus<version number> directory contains system 
software and data files and includes the subdirectories described in 
Tables 2 through 6.

■ The \altera\qdesigns<version number> directory contains tutorial 
and sample files and includes the subdirectories described in Table 6.

The main \altera\quartus<version number> directory includes the 
subdirectories described in Table 1.

Table 1. Quartus II System Directory (quartus<version number>) 
Structure  (Part 1 of 2)

Directory Description

.\bin Contains the stub files that set up the Quartus II software 
environment and prompts the actual executable files located in 
the .\win directory.

.\common Contains device information files and other data files. Refer to 
Table 2 for information on the subdirectories of this directory.
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.\drivers Contains drivers, including the following drivers:

■ EthernetBlaster driver, which is required to use the 
EthernetBlaster download cable with an Ethernet port for 
Windows 2000 and Windows XP

■ ByteBlaster driver, which is required to use the 
ByteBlaster II or ByteBlasterMV download cable with 
Windows 2000 and Windows XP 

■ USB-Blaster driver, which is required to use the USB-Blaster 
download cable with USB for Windows 2000 and 
Windows XP 

■ MasterBlaster USB driver, which is required to use the 
MasterBlaster communications cable with USB for Windows 
2000 and Windows XP 

■ APU USB driver, which is required to use the APU with 
Windows 2000 and Windows XP 

■ Sentinel driver, which is required to use the Sentinel 
Software Guard with node-locked (single-user) licenses for 
Windows 2000, Windows XP, and Windows XP Professional 
x64 Edition

.\drivers\i386 Contains the BBLPT utility, which can be used to install or 
remove the ByteBlaster driver.

.\eda Contains libraries for use with other EDA tools. Refer to Table 3 
for information on the subdirectories of this directory.

.\libraries Contains the Quartus II software directory for “self-contained” 
libraries. Refer to Table 4 for information on the subdirectories 
of this directory.

.\lmf Contains Library Mapping Files (.lmf).

.\sopc_builder Contains files needed for the SOPC builder software.

.\win Contains the executable software program files. Also contains 
Tcl scripts to perform tasks in the Quartus II software and other 
EDA software.

Table 1. Quartus II System Directory (quartus<version number>) 
Structure  (Part 2 of 2)

Directory Description
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The \altera\quartus<version number>\common directory includes the 
subdirectories described in Table 2.

The \altera\quartus<version number>\eda directory includes the 
subdirectories described in Table 3.

Table 2. Quartus II Common Directory (common) Structure

Directory Description

.\advisors Contains the Quartus II software advisor files.

.\devinfo Contains the device information files.

.\flow Contains the command-line options help files.

.\help Contains the Quartus II Help files and the Quartus II software 
PDF tutorial files.

.\ip Contains files to support IP core usage in the Quartus II 
software.

.\tcl Contains Tcl scripting files.

.\misc Contains miscellaneous files that are common across PC 
operating systems.

Table 3. Quartus II EDA Directory (eda) Structure

Directory Description

.\cadence Contains technology libraries for Cadence EDA tools.

.\ibis Contains input files that allow the Quartus II software to 
generate design-specific IBIS Output Files for EDA tools.

.\mentor Contains technology libraries for Mentor Graphics EDA tools.

.\sim_lib Contains VHDL and Verilog HDL simulation libraries that are 
compatible with EDA tools from other vendors.

.\synopsys Contains technology libraries for Synopsys EDA tools.

.\innoveda Contains technology libraries for Mentor Graphics Innoveda 
EDA tools.

.\fv_lib Contains formal verification model libraries.
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The \altera\quartus<version number>\libraries directory includes the 
subdirectories described in Table 4.

The \altera\quartus<version number>\sopc_builder directory includes 
the subdirectories described in Table 5.

Table 4. Quartus II Library Directory (libraries) Structure

Directory Description

.\megafunctions Contains megafunctions, including Library of Parameterized 
Modules (LPM) functions, corresponding Include Files (.inc) that 
contain their AHDL Function Prototypes, and corresponding 
Block Symbol Files (.bsf).

.\others Contains libraries of logic functions that provide compatibility 
between the Quartus II software and the MAX+PLUS II software.

.\primitives Contains Block Symbol Files (.bsf) for Quartus II primitives.

.\software Contains the bootloader library file that generates flash 
programming files with the Quartus II software and the ADS 
Toolset.

.\vhdl87 Contains the library of IEEE std. 1076–1987 VHDL packages.

.\vhdl93 Contains the library of IEEE std. 1076–1993 VHDL packages.

Table 5. Quartus II SOPC Builder Directory (sopc_builder) Structure

Directory Description

.\bin Contains the executable software program files for the SOPC 
Builder software.

.\bin\europa Contains the HDL library generator.

.\components Contains the SOPC Builder software components.

.\placeholders Contains the SOPC Builder placeholders for the available 
components.

.\examples Contains the SOPC Builder example files.

.\documents Contains the SOPC Builder documentation.

.\tutorials Contains the SOPC Builder tutorial files.
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The \altera\qdesigns<version number> directory includes the 
subdirectories described in Table 6.

Table 6. Quartus II Work Directory (qdesigns<version number>) Structure

Directory Description

.\tutorial Contains the completed project and design files for the Basic 
tutorial. This directory includes a readme.txt file that contains 
important information about the tutorial.

.\fir_filter Directory in which you should create the fir_filter project if 
you are completing the Design Entry tutorial module. Use this 
directory to prevent accidental changes to the original design 
files in the \altera\qdesigns<version number>\tutorial 
directory.

.\fir_filter\compile Contains the compile_fir_filter project for use when 
completing the Compilation tutorial module independently or 
nonsequentially.

.\fir_filter\timing Contains the timing_fir_filter project for use when 
completing the Timing Analysis tutorial module independently 
or nonsequentially.

.\fir_filter\simulate Contains the simulate_fir_filter project for use when 
completing the Simulation tutorial module independently or 
nonsequentially.

.\fir_filter\program Contains the program_fir_filter project for use when 
completing the Programming tutorial module independently or 
nonsequentially.
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Revision History

The information contained in the Installation & Licensing for PCs manual 
version 6.0 revision 1 supersedes information published in previous version.

Minor typographical changes were made to the previous version.
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Altera website 38
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CD-ROM
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installing MegaCore IP Library 7
installing ModelSim-Altera software 6
installing Nios II Embedded Processor 
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installing Quartus II software 2
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D

directory structure 41
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driver, installing Sentinel 25
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F

FLEXlm software
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Pentium II 2
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Q

qdesigns directory 41
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serial port 2
Setup program, running 4
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TalkBack, turning on 6
TCP/IP protocol 8
technical support 38

tutorial, starting 35

U

uninstalling Quartus II software 3
USB port 2
USB Software Guard 26

W

Windows 2000 & Windows XP
installing Quartus II software 4
specifying license file 28
TCP/IP Protocol 8


	Installation & Licensing for PCs
	Contents
	Preface
	Documentation Conventions
	Chapter 1: Installing the Quartus II Software
	Introduction
	Quartus II System Requirements
	Uninstalling Previous Versions of the Quartus or Quartus II Software
	Installing the Quartus II Software
	Installing the ModelSimAltera Software
	Installing the MegaCore IP Library
	Installing the Nios II Embedded Design Suite
	Installing the TCP/IP Protocol

	Chapter 2: Licensing the Quartus II Software
	Introduction
	Obtaining a License File
	Modifying the License File
	Upgrading or Setting Up a License Manager Server
	Upgrading the FLEXlm License Server Software
	Rereading an Existing License File
	Configuring a New License Server
	Starting and Stopping the License Server
	Starting the License Server Automatically at Startup
	Installing the FLEXlm Software on Another License Server

	Installing a Sentinel Software Guard
	Installing the Sentinel Driver
	Installing the USB Software Guard
	Installing the Parallel Port Software Guard

	Starting the Quartus II Software
	Specifying the License File
	Specifying the License File within the Quartus II Software
	Specifying the License File with the Windows 2000, Windows XP, or Windows XP Professional x64 Edition System Control Panel

	Registering for an Altera.com Account

	Chapter 3: Documentation & Technical Support
	Starting the Quartus II Tutorial
	Using Quartus II Help
	Getting Help on a Message
	Using Context-Sensitive Help
	Printing Help Topics

	Contacting Altera
	Technical Support
	Product Information


	Appendix A: Quartus II File Organization
	Quartus II File Organization
	Revision History




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


